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Preface

About This Guide

This guide explains how to install and license ISE® Design Suite 11, which includes the 
Integrated Software Environment (ISE) software, ChipScope™ Pro software, Embedded 
Tools (including Embedded Development Kit (EDK) and standalone Software 
Development Kit (SDK)), System Generator, and PlanAhead™ design tools. It also 
describes how to use Xilinx® online documentation. 

Information on what is new, known issues, and technical support for ISE Design Suite 11 
software is also included. 

Guide Contents 
This manual contains the following chapters:

• Chapter 1, “Release Notes for 11.2, 11.3, 11.4 and 11.5”

• Chapter 2, “What’s New, Release Notes, and Known Issues for 11”

• Chapter 3, “Operating Systems, Architecture Support, and System Requirements”

• Chapter 4, “Download and Installation (11.1)”

• Chapter 5, “Obtaining and Managing a License”

• Chapter 6, “Technical Support, Services, and Documentation”

This manual contains the following appendix:

• Appendix A, “Third-Party Licenses”

Additional Resources
To find additional documentation, see the Xilinx website at:

http://www.xilinx.com/support/documentation/index.htm.

To search the Answer Database of silicon, software, and IP questions and answers, or to 
create a technical support WebCase, see the Xilinx website at:

http://www.xilinx.com/support/mysupport.htm.

To obtain the current version of the USB Cable Installation Guide, see the Xilinx website at:

http://www.xilinx.com/support/documentation/user_guides/ug344.pdf
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To obtain the current version of the data sheet for Platform Cable USB II, see the Xilinx 
Website at: 

http://www.xilinx.com/support/documentation/data_sheets/ds593.pdf

To obtain the current version of the data sheet for Parallel Cable IV, see the Xilinx Website 
at:

http://www.xilinx.com/support/documentation/data_sheets/ds097.pdf

Conventions
This document uses the following conventions. An example illustrates each convention.

Typographical
The following typographical conventions are used in this document:

Convention Meaning or Use Example

Courier font
Messages, prompts, and 
program files that the system 
displays

speed grade: - 100

Courier bold
Literal commands that you enter 
in a syntactical statement

ngdbuild design_name

Helvetica bold

Commands that you select from 
a menu

File > Open

Keyboard shortcuts Ctrl+C

Italic font

Variables in a syntax statement 
for which you must supply 
values

ngdbuild design_name

References to other manuals See the Command Line Tools User 
Guide for more information.

Emphasis in text
If a wire is drawn so that it 
overlaps the pin of a symbol, the 
two nets are not connected.

Square brackets    [  ]

An optional entry or parameter. 
However, in bus specifications, 
such as bus[7:0], they are 
required.

ngdbuild [option_name] 
design_name

Braces    {  }
A list of items from which you 
must choose one or more lowpwr ={on|off}

Vertical bar    |
Separates items in a list of 
choices lowpwr ={on|off}
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Conventions
Online Document
The following conventions are used in this document:

Vertical ellipsis 
. 
. 
.

Repetitive material that has 
been omitted

IOB #1: Name = QOUT’  
IOB #2: Name = CLKIN’ 
. 
. 
.

Horizontal ellipsis  . . .
Repetitive material that has 
been omitted

allow block  block_name loc1 
loc2 ... locn;

Convention Meaning or Use Example

Convention Meaning or Use Example

Blue text
Cross-reference link to a location 
in the current document

See the section “Additional 
Resources” for details.

Refer to “Title Formats” in 
Chapter 1 for details.

Red text
Cross-reference link to a location 
in another document 

See Figure 2-5 in the Virtex-5 
Platform FPGA User Guide.

Blue, underlined text Hyperlink to a website (URL)
Go to http://www.xilinx.com 
for the latest speed files.
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Chapter 1

Release Notes for 11.2, 11.3, 11.4 and 11.5

This chapter describes the changes to the ISE® Design Suite software in the 11.2 , 11.3,11.4 
and 11.5 quarterly releases. This chapter comprises the following sections:

• “Production Device Support”

• “Important Changes In 11.5”

• “Architecture Support”

• “Installation: Updating to 11.5”

• “Third-Party Additional License Agreement (Effective Beginning in 11.4)”

For more information about what’s new in this release, see the What’s New documentation 
located at:

www.xilinx.com/support/documentation/sw_manuals/xilinx11/whatsnew.htm

For more information about features and fixes in this release, see:

http://www.xilinx.com/support/answers/33216.htm

Production Device Support 
Xilinx® introduces production support for the following Spartan®-6 and Virtex®-6 
devices in the 11.5 release:

Production Device Support
• Spartan-6 LX16 (-2C, -2I) speed files

• Spartan-6 LX45/T (-2C, -2I) speed files

• Virtex-6 LX240T (-1C, -1I, -2C, -2I) speed files

• Virtex-6 LX130T (-1C, -2C) speed files

• Support for future Spartan-6 and Virtex-6 production devices

• Updated speed files for all other Spartan-6 and Virtex-6 production devices

Note: Embedded Development Kit (EDK) support for all Spartan-6 and Virtex-6 device families is 
considered pre-production. EDK production support for these families will be provided in upcoming 
releases.

Note: Production devices will still have speed files labeled as “Preliminary” in the software. 
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For the latest status on production devices, please check the following data sheets.

Virtex-6: Virtex-6 FPGA Data Sheet: DC and Switching Characteristics (DS152) - See 
table entitled “Virtex-6 Device Production Software and Speed Specification Release.” 

Spartan-6: Spartan-6 FPGA Data Sheet: DC and Switching Characteristics (DS162) - 
See table entitled “Spartan-6 Device Production Software and Speed Specification 
Release.”

Important Changes In 11.5
11.5 includes important updates and supports production devices for the Virtex-6 and 
Spartan-6 families. However, several workarounds may be required for Virtex-6 and 
Spartan-6 customers using 11.5. Please review software Answer Record 32147, Spartan-6 
Answer Record 32651, and Virtex-6 Answer Record 32929 before you upgrade to 11.5. The 
workarounds described in these answer records will be addressed in 12.1, scheduled for 
May 2010. Designers targeting families other than Virtex-6 or Spartan-6 do not need to 
install 11.5, and should remain at 11.4.

If you are using 11.5 for families other than Virtex-6 or Spartan-6, and you are experiencing 
errors or significant changes in the quality of results, it is recommended that you revert 
back to 11.4.

Logic Edition – Summary of Changes
• The Virtex-6 FPGA MMCM has the following new requirements:

♦ When fixed phase shift, variable phase shift, or the Dynamic Reconfiguration Port 
(DRP) feature is used in the MMCM, a calibration circuit is required to be inserted 
into the user design.

♦ The minimum VCO frequency of the MMCM is now 600 MHz (was 400 MHz.)

♦ The CLKFBOUT_MULT_F attribute (the multiply of the MMCM) cannot be set to 
fractional values or a value of 3 or 4.

For more information on 11.5 Virtex-6 MMCM requirements, please see Answer 
Record 33849.

• Average 5% faster performance for Spartan-6 -2 speedgrade, compared to 11.4, with 
latest speed files.

• Multi-Corner Timing Analysis for Spartan-6. The benefits of multi-corner timing 
analysis are:

♦ Faster PERIOD performance due to decreased clock skew.

♦ Faster I/O performance due to decrease min/max variation.

Embedded Edition – Summary of Changes
Installation of 11.5 breaks all Virtex-6 designs containing the Multi-port Memory 
Controller (MPMC) and Tri-mode Ethernet (LL_TEMAC). There are several workarounds 
to these issues that are required for Virtex-6 customers using EDK 11.5. Please review 
Answer Record 34099 and Answer Record 34678 before you upgrade to 11.5. These 
workarounds will be addressed in 12.1, scheduled for May 2010. Designers targeting 
families other than Virtex-6 or Spartan-6 do not need to install 11.5, and should remain at 
11.4.
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Important Changes In 11.5
Installation of 11.5 results in implementation failures when targeting SP601 based dual 
processor designs generated using Base System Builder (BSB). For the workaround for this 
issue, please see Answer Record 34566.

Xilinx IP Cores – 11.5 Changes and Requirements
This section briefly describes the changes and requirements for Virtex-6 and Spartan-6 
designs.

Virtex-6 Designs

For Virtex-6 designs, the following IP have been updated for 11.5. The new 11.5 versions of 
these cores must be used to ensure proper functionality and timing. If you are using the 
following IP in a Virtex-6 design, each core should be regenerated in 11.5 and the design 
should then be re-implemented. If you are using EDK flows in 11.5, even with families 
other than Virtex-6, the updated IP cores may be incorporated automatically into your 
designs. This may produce results that differ from previous 11.x versions, and the design 
should be re-checked for validity.

• 10 Gigabit Ethernet MAC 

• Aurora 64b66b 

• Aurora 8b10b 

• Block Memory Generator

• Clocking Wizard 

• CPRI 

• Embedded PCI Express Bridge (PCIe®)

• Ethernet 1000BASE-X PCS/PMA or SGMII 

• FIFO Generator

• OBSAI 

• RXAUI 

• RapidIO Physical Layer Interface, RapidIO Logical (I/O) and Transport Layer 
Interface Core 

• SPI-3 Link Layer 

• SPI-4.2, SPI-4.2 Lite 

• Tri-Mode Ethernet MAC 

• Virtex-6 FPGA Embedded Tri-Mode Ethernet MAC 

• Virtex-6 GTX Wizard 

• Virtex-6 Integrated Block for PCI Express 

• XAUI 

Spartan-6 Designs

For Spartan-6 designs, the following IP have been updated for 11.5. The new 11.5 versions 
of these cores must be used to ensure proper functionality and timing. If you are using the 
following IP in a Spartan-6 design, each core should be regenerated and the design re-
implemented. If you are using EDK flows, even with families other than Virtex-6, the 
updated IP cores may be incorporated automatically into your designs. This may produce 
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results that differ from previous 11.x versions, and the design should be re-checked for 
validity.

• SPI-4.2 Lite

• RapidIO Logical (I/O) and Transport Layer Interface Core

• RapidIO Physical Layer Interface Core

• Tri-Mode Ethernet MAC

Architecture Support

Virtex-6 and Spartan-6 Device Support
Virtex-6 and Spartan-6 devices support was added in ISE Design Suite 11.2, and updated in 
11.4. Other supported architectures in 11 are found in Table 3-4, page 25.

Table 1-1: Virtex-6 and Spartan-6 Device Support

ISE WebPACK™
ISE Design Suite

(Logic Edition, Embedded Edition, DSP 
Edition, System Edition)

Virtex Series

Virtex-6: 

LXT: XC6VLX75T, XC6VLX75TL

Virtex 6:

• LX/T:  All including "L" (lower 
power) devices

• CXT:  All
• SXT:  All including "L" (lower power) 

devices
• HXT: All

Note: Embedded Development Kit (EDK) 
11.4 does not support the following devices: 

♦ Virtex-6 LX/T L (lower power)

♦ Virtex-6 SXT L (lower power)

♦ Virtex-6 HXT

EDK 11.4 provides early-access support 
only for remaining Virtex-6 LX/T and Virtex-
6 SXT devices.

Spartan Series Spartan-6: 

LX/T: XC6SLX4, XC6SLX4L, XC6SLX9, 
XC6SLX9L, XC6SLX16, XC6SLX16L, 
XC6SLX25, XC6SLX25L, XC6SLX25T, 
XC6SLX45, XC6SLX45L, XC6SLX45T, 
XC6SLX75, XC6SLX75L, XC6SLX75T

XA* Spartan-6: All

Note: Spartan-6 XC6SLX4, Lower Power 
Spartan-6, and XA devices are new in ISE 
WebPACK 11.4

* XA = Xilinx Automotive 

Spartan 6:

LX/T: All including "L" (lower power) 
devices

XA Spartan-6: All

Note: EDK 11.4 provides early-access 
support only for Spartan-6 devices.
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Installation: Updating to 11.5
Virtex-5 Device Support 
Virtex-5Q series devices were released in 11.2. These devices are available in the ISE Design 
Suite software, not in ISE WebPACK or EDK 11.4.

Installation: Updating to 11.5
ISE Design Suite 11.5 is being delivered as an update that needs to be installed onto an 
existing 11.1, 11.2, 11.3 or 11.4 installation.

To update to 11.4:

1. Make sure you have ISE Design Suite 11.1, 11.2, 11.3 or 11.4 installed on your machine.

If you do not have at least ISE Design Suite 11.1 installed on your machine, install it by 
following the instructions in Chapter 4, “Download and Installation (11.1).” See 
sections:

♦ “Downloading ISE Design Suite 11” 

♦ “Installing ISE Design Suite 11 - Overview for All Platforms”

2. Upgrade your 11.1 or 11.2 version to 11.5 by following the instructions in Chapter 4, 
“Download and Installation (11.1).” See section:

♦ “Obtaining Software Updates”

Third-Party Additional License Agreement (Effective Beginning in 
11.4)

The following license agreement is effective in the 11.4 release.

Libconfig (v1.3.2) License
libconfig - A library for processing structured configuration files

Copyright (C) 2005-2009 Mark A Lindner

This file is part of libconfig. 

This library is free software; you can redistribute it and/or modify it under the terms of the 
GNU Lesser General Public License as published by the Free Software Foundation; either 
version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE.  See the GNU Lesser General Public License for more 
details. 

You should have received a copy of the GNU Library General Public License along with 
this library; if not, see <http://www.gnu.org/licenses/>.
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Chapter 2

What’s New, Release Notes, and Known 
Issues for 11

This chapter discusses important product details and describes how to access the list of 
new features that are included in the products that comprise ISE® Design Suite 11. It also 
describes how to access the Known Issues for ISE Design Suite 11. This chapter comprises 
the following sections:

• “What’s New”

• “Release Notes”

• “Known Issues”

What’s New
This section describes the different ways to access the What’s New documentation.

Microsoft Windows Only
You can view the What’s New documentation by selecting Start > Programs > Xilinx ISE 
Design Suite 11 > Documentation > What’s New.

Microsoft Windows and Linux
The What’s New documentation is contained in a file called whatsnew.htm, which is 
located in \Xilinx\11.1\common, where \Xilinx\11.1 is the default directory. 

Online
You can find the What’s New documentation online at:

www.xilinx.com/support/documentation/sw_manuals/xilinx11/whatsnew.htm

The DSP tools, AccelDSP™, and System Generator are included in ISE Design Suite 11. For 
more information on these specific products, see their respective What’s New files:

www.xilinx.com/ise/dsp_design_prod/acceldsp/acceldsp-new.htm

www.xilinx.com/products/software/sysgen/whatsnew.htm
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Release Notes
This section describes important release information.

ISE Foundation Tools
A few ISE Foundation™ tools have been removed or have limited support. The following 
table lists these tools along with their current replacement or support level.

DSP Tools
Further development of the AccelDSP synthesis tool has been discontinued. You may 
continue to use this version of the tool with ISE Design Suite 11. The tool will not be 
included in ISE Design Suite 12.

For additional release information specific to the DSP tools, AccelDSP Synthesis Tool and 
System Generator, see their respective Release Notes files:

www.xilinx.com/support/documentation/sw_manuals/acceldsp_rn.pdf

www.xilinx.com/support/documentation/sw_manuals/sysgen_gs.pdf

CORE Generator IP Notes
The first Intellectual Property (IP) Update for the ISE Design Suite 11 CORE Generator™ 
software, IP_11.1.0, is integrated into the initial ISE Design Suite 11 software release and is 
automatically installed with it.

Subsequent ISE 11-compatible updates are cumulative and will be advertised on the Xilinx 
Intellectual Property Center, http://www.xilinx.com/ipcenter, as they become available. 
These future updates will be downloadable from the Xilinx Download Center, and will 
also usually require installation of specific ISE updates. 

Some IP cores might also require license purchase or installation of a license key to activate 
full access. IP-specific requirements along these lines are documented on the product page 
for each core.

Embedded Tools
Base System Builder now supports the Xilinx SP601 and ML605 development boards. 

Note: All Virtex®-6 and Spartan®-6 device support is Early Access 

Table 2-1: Tools removed or with limited support

Tools Alternative or Support Level

Floorplanner Use PlanAhead

PACE CPLD support only

ABEL Support Use ISE Design Suite 10.1

StateCAD Use ISE Design Suite 10.1

HDL Bencher Use HDL Testbench Examples
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Known Issues
ModelSim Xilinx Edition III
For ModelSim Xilinx Edition III information see Appendix A, “Simulating Xilinx Designs 
in ModelSim” in the Synthesis and Simulation Design Guide.

To Simulate Xilinx Designs in ModelSim, you must use the Compxlib to compile the 
Xilinx® Simulation Libraries for the target simulator. For more information, see the 
Command Line Tools User Guide.

PlanAhead
Updated Device Support, including the new Spartan-6 low power family. New Virtex-6 
SSN Predictor tool for pin assignment.

Known Issues
Xilinx Answer Record #32147 contains information on Known Issues for ISE Design Suite 
11:

http://www.xilinx.com/support/answers/32147.htm
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Chapter 3

Operating Systems, Architecture 
Support, and System Requirements

This chapter describes the operating systems and architectures that the ISE® Design Suite 
11 software supports. It also describes system requirements for ISE Design Suite 11. This 
chapter comprises the following sections:

• “Operating Systems”

• “Architectures”

• “System Requirements”

Operating Systems
ISE Design Suite 11 supports three operating systems: Microsoft Windows®, Red Hat® 
Enterprise Linux, and SUSE Linux Enterprise. 

Microsoft Windows
The following table lists Microsoft Windows support.

Table 3-1: Microsoft Windows Support (English and Japanese)

Product
XP Professional Vista Business

32-bit 64-bit 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation™) Yes Yes Yes Yes

ISE Simulator (ISim) Yes No Yes No

ISE WebPACK™ Yes No Yes No

ChipScope™ Pro and ChipScope Pro Serial I/O Toolkit Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes No Yes No

System Generator for DSP Yes No Yes No

AccelDSP™ Synthesis Tool Yes No No No

ModelSim Xilinx Edition-III (MXE-III) Yes No Yes No
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Red Hat Enterprise Linux
The following table lists Red Hat Enterprise Linux support.

SUSE Linux Enterprise
The following table lists SUSE Linux Enterprise 10 support.

* System Generator supports English only.

Table 3-2: Red Hat Enterprise Linux Support

Product
4 Workstation 5 Desktop

32-bit 64-bit 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation) Yes Yes Yes Yes

ISE Simulator (ISim) Yes Yes Yes Yes

ISE WebPACK Yes No Yes No

ChipScope Pro and ChipScope Pro Serial I/O Toolkit Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes Yes Yes Yes

System Generator for DSP Yes Yes Yes Yes

ModelSim Xilinx Edition-III (MXE-III) No No No No

Table 3-3: SUSE Linux Enterprise 10 Support (English and Japanese)

Product 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation) Yes Yes

ISE Simulator (ISim) Yes Yes

ISE WebPACK Yes No

ChipScope Pro and ChipScope Pro Serial I/O Toolkit Yes Yes

Embedded Development Kit (EDK) Yes Yes

System Generator for DSP* Yes Yes

ModelSim Xilinx Edition-III (MXE-III) No No
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Architectures
ISE Design Suite 11 supports three architecture families: Virtex®, Spartan®, and CPLD. The 
following table lists the architecture support. 

Note: ISE Design Suite 11.2 and 11.3 support two additional architecture families: Virtex-6 and 
Spartan-6. For details, see Table 1-1, page 16. 

Table 3-4: Architecture Support

ISE WebPACK
ISE Design Suite

(Logic Edition, Embedded Edition, DSP 
Edition, System Edition)

Virtex Series Virtex-4:

LX: XC4VLX15, XC4VLX25

SX: XC4VSX25

FX: XC4VFX12

Virtex-5:

LX: XC5VLX30, XC5VLX50

LXT: XC5VLX20T, XC5VLX30T, XC5VLX50T

FXT: XC5VFX30T

Virtex-4:

LX: All

SX: All

FX: All

Virtex-5:

LX: All

LXT: All

SXT: All

TXT: All

FXT: All

Note: Embedded Development Kit (EDK) 
does not support Virtex-5 TXT.

Spartan Series Spartan-3: XC3S50 - XC3S1500

Spartan-3A: All

Spartan-3AN: All

Spartan-3A DSP: XC3SD1800A

Spartan-3E: All

Spartan-3L: XC3S1000L, XC3S1500L

XA* Spartan-3: All

XA* Spartan-3E: All

XA* Spartan-3A: All

XA* Spartan-3A DSP: XC3SD1800A

*Xilinx Automotive

Spartan-3: All

Spartan-3A: All

Spartan-3AN: All

Spartan-3A DSP: All

Spartan-3E: All

Spartan-3L: All

XA* Spartan-3: All

XA* Spartan-3E: All

XA* Spartan-3A: All

XA* Spartan-3A DSP: All

*Xilinx Automotive

CoolRunner™ XPLA3

CoolRunner-II

XA* CoolRunner-II

*Xilinx Automotive

All

All 

Note: Embedded Development Kit (EDK) 
does not support CPLDs.

XC9500 Series All (Except 9500XV Family) All (Except 9500XV Family)

Note: Embedded Development Kit (EDK) 
does not support CPLDs
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Device Obsolescence
The following devices are not supported in ISE Design Suite 11:

• Virtex

• Virtex-E

• Virtex-II

• Virtex-II Pro

• Spartan-II

• Spartan-IIE

• 9500XV

All families, except 9500XV, are still being manufactured with no plans to discontinue. ISE 
Design Suite 10.1 SP3 is available for download to support the discontinued devices.

System Requirements
This section provides information on supported operating systems, Web browser, cable 
installation, and system memory requirements.

ISE Design Suite

Cable Installation Requirements

Platform Cable USB II and Parallel Cable IV are high-performance cables that enable 
Xilinx® design tools to program and configure target hardware.

To install Platform Cable USB II, a system must have at least a USB 1.1 port. For maximum 
performance, Xilinx recommends using Platform Cable USB II with a USB 2.0 port.

To install Parallel Cable IV, a system must have a parallel port connector and support 
parallel port communication.

Cables are officially supported on the 32-bit and 64-bit versions of the following operating 
systems: Windows XP Professional, Windows Vista Business, Red Hat Linux Enterprise, 
and SUSE Linux Enterprise 10. Additional platform specific notes are as follows:

• All Linux: Root privileges are required to install cable drivers on Linux. 

• SUSE Linux Enterprise 10: The fxload software package is required to ensure correct 
Platform Cable USB II operation. The fxload package is not automatically installed on 
SUSE Linux Enterprise 10 distributions, and must be installed by the user or System 
Administrator. 

• Linux LibUSB support: Preliminary support for Platform Cable USB II based upon the 
LibUSB package is now available from the Xilinx website. See Answer Record #25249 
for details. 

For additional information regarding Xilinx cables, refer to the following documents:

• USB Cable Installation Guide (UG344)

• Platform Cable USB II Data Sheet (DS593)

• Parallel Cable IV Data Sheet (DS097)
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System Memory Recommendations

This section gives the RAM and swap space needed to run ISE Design Suite 11 on your 
system.

While the memory recommendation table, available at the link below, lists the system 
recommendations for typical designs, the unique characteristics of each design affect the 
system resources required. Design complexity and constraints affect whether the design 
can be implemented using more or less memory. Each designer must monitor the system 
resources and adjust the systems resources, if necessary. For more information on memory 
recommendations, see:

http://www.xilinx.com/ise/products/memory.htm

Operating Systems and Available Memory

The Microsoft Windows and Linux® operating system (OS) architectures have limitations 
on the maximum memory available to a Xilinx program. Users targeting the largest 
devices and most complex designs may encounter this limitation. ISE Design Suite 11 has 
optimized memory and enabled software support for applications to increase RAM 
memory available to Xilinx software. 

Windows XP Professional 32-bit

Xilinx applications are enabled to take advantage of the memory increase feature on 
Windows 32-bit. You must then modify Windows setting to get access to this larger 
memory. 

The standard Windows OS architecture limits the maximum memory available to a Xilinx 
process to 2 Gigabyte (GB). In Windows XP Professional, Microsoft created an option to 
support the ability of an application to address 3 GB of RAM. Xilinx ISE applications have 
built-in support for this option. To take advantage of this capability, you must also modify 
your Windows XP OS to enable this feature, which requires that you modify your 
boot.ini file by adding a “/3GB” entry to the end of the “startup” line.

Before enabling 3 GB support for Xilinx applications, please read the Microsoft Knowledge 
Base Article #328269 at http://support.microsoft.com/?kbid=328269. If you upgrade your 
computer to Windows XP Service Pack 1 (SP1) and you are using the /3GB switch, 
Windows may not restart without a patch from Microsoft. Please see (Xilinx Answer 17905) 
for more information. 

Additionally, before making this change, please read: 

• Microsoft Bulletin Q17193 http://support.microsoft.com/default.aspx?scid=kb;en-
us;Q171793, which contains information on “Application Use of 4GT RAM Tuning”.

• Microsoft Bulletin Q289022 http://support.microsoft.com/default.aspx?scid=kb;en-
us;q289022, contains instructions for editing your boot.ini file. 

Linux

ISE Design Suite 11 supports both Linux 32-bit and Linux 64-bit. The latter allows greater 
memory allocation. Xilinx has documented Linux kernel modifications that allow a Xilinx 
application to address over 3 GB of memory. 

For 32-bit Red Hat Enterprise Linux systems, the operating system can use the hugemem 
kernel to allocate 4 GB to each process. More information can be found on the Red Hat 
support site: http://www.redhat.com/docs/manuals/enterprise/
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ISE supports the 64-bit version of Red Hat Enterprise Linux, which allows greater memory 
allocation out of the box.

Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 3-5: Equipment and Permissions Requirements 

Note: X Servers/ Remote Desktop Servers, such as Exceed, ReflectionX, and XWin32, are not 
supported.

Network Time Synchronization

When design files are located on a network machine, other than the machine with the 
installed software, the clock settings of both machines must be set the same. These times 
must be synchronized on a regular basis for continued proper functioning of the software.

ChipScope Pro and ChipScope Pro Serial I/O Toolkit

Cable Installation Requirements

For Linux, cable drivers require root privileges to install. To install Platform Cable USB II 
for USB 2.0 port, you must have Windows XP SP2. The Platform Cable USB II is a high-
performance download cable that attaches to user hardware for use with the ChipScope 
Pro Analyzer tool for device programming, configuring, and debugging. 

System Memory Recommendations

The ChipScope Pro Analyzer requires 1024 megabytes (MB) of system memory. The 
ChipScope Pro Core Inserter tool has the same requirements as ISE. For more information 
on ISE memory recommendations, see: 
http://www.xilinx.com/ise/products/memory.htm. 

Item Requirement

Directory permissions Write permissions must exist for all directories containing 
design files to be edited. 

Monitor 16-bit color VGA with a minimum recommended resolution of 
1024 by 768 pixels. 

Drive You must have a DVD-ROM for ISE Design Suite (if you have 
received a DVD, rather than downloading from the web), and 
CD-ROM for MXE on your system.

Ports To program devices, you must have an available parallel, or 
USB port appropriate for your Xilinx programming cable. 
Specifications for ports are listed in the documentation for your 
cable.

Note: Installation of the cable driver software requires Windows 
XP Pro SP1 (or later), or Windows Vista Business. If you are not 
using one of these operating systems, the cables may not work 
properly.
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System Requirements
DSP Tools System Requirements and Recommendations

Hardware Recommendations

OS and Software Requirements

Table 3-6: AccelDSP and System Generator for DSP Hardware Recommendations

Recommendation Notes

2.00 GB of RAM

600 MB of hard disk space Minimum Requirement

Xilinx Hardware Co-Simulation Platform Required for the Hardware Co-Simulation Flow

Table 3-7: AccelDSP Synthesis Tool OS and Software Requirements

Requirement Notes

Windows XP SP2, 32-bit The AccelDSP synthesis tool does not support 
Windows Terminal Services.

Xilinx ISE Design Suite 11

MathWorks MATLAB® Version 2008a or 
2008b

MathWorks Simulink® with Fixed-Point 
Toolbox Version 2008a or 2008b

Required for the System Generator Flow

Table 3-8: System Generator for DSP OS and Software Requirements

Requirement Notes

Windows XP SP2, 32-bit (English only) 

or 

Red Hat Linux 4u7, 32-bit & 64-bit

Xilinx ISE Design Suite 11

MathWorks MATLAB Version 2008a or 
2008b

MathWorks Simulink with Fixed-Point 
Toolbox Version 2008a or 2008b

MATLAB must be installed in a directory with 
no spaces (e.g., C:\MATLAB\R2008b)

Fixed-Point Toolbox required for signals 
greater than 53 bits
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Chapter 4

Download and Installation (11.1)

This chapter describes how to download and install ISE® Design Suite 11 software, as well 
as ModelSim Xilinx® Edition 6.4b. It includes the following sections:

• “Downloading ISE Design Suite 11”

• “Installing ISE Design Suite 11 - Overview for All Platforms”

• “Platform Specific Instructions”

• “Installation Flow”

• “USB FLEXid Dongle Driver Installation”

• “Network Installations”

• “Obtaining Software Updates”

• “Uninstalling ISE Design Suite 11”

• “Installing ModelSim Xilinx Edition 6.4b Software (Windows Only) - Optional”

Downloading ISE Design Suite 11
This section explains how to download the ISE Design Suite 11 software. All files will be 
downloaded using the Akamai download manager. 

For the optimum download experience:

♦ Allow pop-ups from entitlenow.com

♦ Set security settings to allow for secure and non-secure items to be displayed on 
the same page

♦ Allow the Akamai download manager to run Java processes

Software updates for all platforms are regularly made available on the Download Center 
at: 

http://www.xilinx.com/support/download/index.htm

From this page, perform the following:

1. Click the Login to start downloading link.

2. Enter your User ID and Password to log into your Xilinx account.

Note: If you do not have a Xilinx account, you will need to create one in order to download 
products.

An address verification screen will appear.

3. Once the current address is correct, click Next.
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Install Over the Web (Unavailable after 12.1 begins shipping)
Installing over the web requires the download, installation, and execution of a Xilinx Web 
Install Client. This Web Install Client offers a single step installation procedure in which 
only the software components you select are downloaded and installed. This selection may 
save considerable time and bandwidth, depending on your installation needs.

To install over the web:

1. Click Download Web Install Client.

A compressed ZIP format file containing the Web Install Client will be downloaded to 
your computer.

2. Extract the contents of the file to your hard drive.

3. Run xsetup.exe (Windows) or xsetup (Linux).

Follow the instructions in the “Installing ISE Design Suite 11 - Overview for All 
Platforms” section below.

Download Individual Files
The Download Individual Files option is useful if you would prefer to download 
installation files for future use. You can download a version of the full DVD image or 
versions of individual product-specific installers. These files are packaged using TAR 
methods. You will need to use software from a third party provider to unpack them. 
Consult your IT department for assistance. Commonly used tools for TAR files are 7-ZIP, 
GNU built-in tools, WinZIP, and WinRar, and these are licensed solely by each respective 
developer and not Xilinx. Xilinx hereby disclaims any warranties, express or implied, 
including warranties of merchantability, fitness for a particular purpose, or 
noninfringement with respect to these suggested software tools.

Installing ISE Design Suite 11 - Overview for All Platforms
This section explains the installation process for all platforms for ISE Design Suite 11. 
Installation for each platform should be preceded by these steps:

1. Ensure that you have appropriate privileges on the system that the software will be 
installed on. Some components, such as programming cable device drivers, require 
administrator-level permissions.

2. Close all programs before you begin installation.

3. Ensure that your system meets the requirements described in Chapter 3, “Operating 
Systems, Architecture Support, and System Requirements.”

4. Check the links found in Chapter 2, “What’s New, Release Notes, and Known Issues 
for 11”for any installation issues that pertain to your system or configuration.

5. Ensure if EDK is installed, the installation has to be in a directory structure that does 
not contain spaces.

After installation, if it has not already been done by the installer, manually set your XILINX 
Environment Variable before using the ISE Design Suite 11 software. For more information, 
see “Platform Specific Instructions.” 
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Platform Specific Instructions
This section provides platform-specific details of the ISE Design Suite 11 installation. 

Microsoft Windows 
This section describes how to start the installation for Microsoft Windows operating 
systems.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See “Downloading ISE Design Suite 11” for details on your options.

• If you have downloaded either the WebInstall Client, or have used the “Download 
Files Individually” option for a particular product, decompress that file and run the 
xsetup.exe program contained therein.

• If you have ordered and received an ISE Design Suite DVD, load the DVD. If you have 
the auto-run feature of your DVD drive enabled, the setup program should start 
automatically. If it does not, browse to the DVD in Windows Explorer and run the 
xsetup.exe found at the root of the disc.

Linux
This section describes how to start the installation and set the environment variables for 
Linux operating systems.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See “Downloading ISE Design Suite 11” for details on your options.

• If you have downloaded either the WebInstall Client, or have used the “Download 
Files Individually” option for a particular product, decompress that file and run the 
xsetup program contained therein.

• If you have ordered and received an ISE Design Suite DVD, load the DVD. Click the 
setup file in your file manager, or browse to the root of your DVD drive and type 
./xsetup. 

To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variables file for you. 

1. Go to your XILINX installation directory.

2. Type either source settings32.(c)sh or source settings64.(c)sh, 
whichever is appropriate to your shell.

To set your environment variables manually or from within your setup script, it is 
recommended that you copy the settings from the appropriate file for your operating 
system, as listed above. Xilinx environment variables settings are specific to each operating 
system platform.
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Installation Flow
The following section describes important screens that you will encounter during the 
installation process.

Note: For each of the following installation steps, click on the text of any item that has a checkbox 
next to it to obtain more information. Information is displayed in the “Description of Highlighted Item 
Above” area near the bottom of the screen.

Accept Software Licenses
There are two Accept Software License Agreement Screens you will have to click through. 
To proceed:

1. Click the I accept the terms of this software agreement checkbox.

2. Click Next on each screen.

Selecting Xilinx Products
The following figure shows the screen that allows you to select the Xilinx products you 
wish to install. Products are grouped inside categories and the default category selected is 
called ISE Design Suite Product. Leaving all products in this category checked will install 
the entire ISE Design Suite. 
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Installation Flow
Note: PlanAhead™ analysis tool and DSP tools are checked by default when ISE Design Tools are 
checked. This is due to a dependency that the ISE Design Tools have upon these other products. To 
install PlanAhead only, uncheck ISE Design Tools, and PlanAhead will become individually 
selectable.

Select Destination Directory
In the Select Destination Directory screen, select the directory in which to install the 
software, and enter a name for the Program Folders list. By default, the directory is set to 
C:\Xilinx\11 and the Program Folders Name is listed as Xilinx ISE Design Suite.

Select Installation Options
There are three Select Installation Options screens which allow you to select Xilinx 
modules and devices, set environment variables, and choose additional install options.

X-Ref Target - Figure 4-1

Figure 4-1: ISE Design Suite 11 Installation - Select Xilinx Products Screen
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Selecting Xilinx Modules and Devices

The following figure shows the screen from the Installation Software that enables you to 
select Xilinx products, modules, and device families you wish to install. 

Set Environment Variables

The installer provides an option to set the environment variables required by each Xilinx 
Design Suite product to appropriate values. The following figure shows the Select 
Installation option screen in which environment variables are set.

X-Ref Target - Figure 4-2

Figure 4-2: ISE Design Suite 11 Installation - Xilinx Modules and Devices
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Installation Flow
Selecting Additional Options

Additional options can be selected from this screen. The following figure shows an 
example of how this screen will look.

X-Ref Target - Figure 4-3

Figure 4-3: ISE Design Suite 11 Installation - Select Environment Variables Screen
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Begin Installation
The Begin Installation Screen gives you a summary of the tools, products, and options to be 
installed. If you want to change anything, select the Back button and make the desired 
changes. To begin the installation, click Install.

Towards the end of the installation process, the Xilinx License Configuration Manager will 
open by default. Follow the instructions in the Manager to obtain or locate a license file. 

Following licensing, XilinxUpdate will open to enable you to install any updates that are 
currently available.

USB FLEXid Dongle Driver Installation
If you have purchased a USB FLEX ID Dongle for use with Windows operating systems, 
you will need to install the appropriate driver prior to creating a FLEXnet license for use 
with it.

1. Install Xilinx ISE Design Suite 11.1 software first. This will contain the installer for the 
USB FLEXid dongle driver.

2. Run FLEXId_Dongle_Driver_Installer.exe found in <Xilinx 
Installation Directory>\11.1\ISE\bin\nt.

3. On the Select Options screen, ensure that only FLEXid 9 Drivers is checked.

X-Ref Target - Figure 4-4

Figure 4-4: ISE Design Suite 11 Installation - Select Installation Options Screen
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Network Installations
4. Click Next twice, and the driver will install. 

After installation, a screen will appear asking you if you wish to reboot. You will need to 
reboot to ensure that the dongle operates correctly.

Network Installations
Installing software to a network location provides a way for client machines to access the 
software by pointing to it on the network drive. To run the software on the network, the 
client machines must be set up correctly to ensure that the environment variables, registry, 
and program groups all point to the network. The following sections describe the 
procedure for network setups.

UNIX Clients
Each software user must source settings32.(c)sh or settings64.(c)sh 
(whichever is appropriate for your OS) from the $XILINX area where the software is 
installed. This points the Xilinx environment variable, path, and LD_LIBRARY_PATH to 
the installed location.

X-Ref Target - Figure 4-5

Figure 4-5: Select Options screen
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To run the software applications from a remotely installed location, run an X Windows 
display manager, and include a DISPLAY environment variable. Define DISPLAY as the 
name of your display. DISPLAY is typically unix:0.0. For example, the following syntax 
allows you to run the software on the host named bigben and to display the graphics on 
the local monitor of the machine called mynode:

setenv DISPLAY mynode:0.0

xhost = bigbenPC Clients

Microsoft Windows Clients
1. Install the ISE software tools to a PC network server. Make sure that your users know 

the location of the software tools and have access to the installation directory, and that 
they have Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory: 
network_install_location\common\bin\nt and run the program 
remotexsetup.bat.

Running this program sets up the environment and registry settings needed to run the 
Xilinx tools from the remote location. 

3. From the client machine, launch the ISE tools via the Program Group or Desktop 
shortcuts, or by running the applications on the network drive.

Installing to a Mounted Network Drive
Xilinx software is designed to be installed in a directory under ROOT (typically C: \Xilinx). 
The installer presents this option normally when installing to a local driver, but when 
installing to a mounted network drive, a subdirectory might not be defined and it appears 
to the Installer as if it is installing to a ROOT directory.

To work around this issue, define your target installation directory as "\Xilinx" under the 
network mount point (For example: "N:\Xilinx").

EDK Windows Environment Variables and Registry Settings
The EDK installer creates or modifies the following variables on your machine. These 
variables are added to the system settings. 

♦ XILINX_EDK

Sets the value of this variable to the EDK installation directory.

♦ PATH

Prefixes the PATH environment variable with 

%XILINX_EDK%\bin\nt;%XILINX_EDK%\lib\nt;%XILINX_EDK%\bin\nt;%XILIN
X_EDK%\bin\nt

EDK tools require the Cygwin tools distributed by Red Hat. A copy of these tools is 
distributed with the EDK installation. When you run XPS, the SDK IDE, or Xilinx Shell, 
your registry is checked for the entry: 

My Computer\HKEY_CURRENT_USER\SOFTWARE\Cygnus Solutions\Cygwin. 

If a compatible version of Cygwin is found pre-installed on your machine, the EDK tools 
use it. Otherwise, the registry is set up to point to the Cygwin tools distributed in the EDK 
installation area. 
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Obtaining Software Updates
When you install EDK, Cygwin installation files are copied to your system. Whether or not 
the copied files are installed depends on the state of existing Cygwin installations on the 
machine. If you have Cygwin installed already, and if the existing Cygwin installation 
meets requirements, EDK does not install Cygwin (and the existing Cygwin installation is 
used). Otherwise, EDK installs Cygwin from the installation area. For more information, 
refer to the “EDK Shell” Chapter in the Embedded System Tools Reference Manual, available 
at:

http://www.xilinx.com/support/documentation/dt_edk_edk11-1.htm

Linux EDK Environment Variables
EDK installer creates settings.csh and settings.sh files in the EDK installation 
directory. These files set up the environment for using the EDK tools. 

♦ $XILINX_EDK

Sets the value of this variable to the installation directory.

♦ $PATH

Prefixes the $PATH environment variable with:

- $XILINX_EDK/gnu/microblaze/lin/bin

- $XILINX_EDK/gnu/powerpc-eabi/lin/bin/

♦ $LD_LIBRARY_PATH

Prefixes the $LD_LIBRARY environment variable with $XILINX_EDK/bin/lin.

Note: While executing the script, make sure that the $XILINX_EDK/bin/lin appears before 
$XILINX/bin/lin in the $LD_LIBRARY_PATH variable.

Obtaining Software Updates
The following sections describe the ways to obtain software updates through XilinxUpdate 
and the Download Center.

XilinxUpdate
The XilinxUpdate tool is the preferred method of obtaining software updates. It provides 
the following features: 

• Compares the latest version of software updates available on 
http://www.xilinx.com/support with what you have installed, and notifies you if a 
newer version is available. 

• Downloads and installs the update in one step. 

• Downloads only the files necessary to update your installation. 
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Chapter 4: Download and Installation (11.1)
By default, XilinxUpdate automatically runs at the conclusion of the ISE Design Suite 11 
installation process. In addition, it can run after installation in any of the following ways: 

• Automatic periodic checks at Project Navigator startup time. 

• Select Help > XilinxUpdate from Project Navigator. 

• Select Start > Programs > Xilinx ISE Design Suite 11 > ISE > Accessories > 
XilinxUpdate. 

Note: If you unchecked the option of running XilinxUpdate during the initial software installation, it is 
strongly recommended that you run it as soon as is practical in order to ensure that you have the 
latest updates and enhancements.

Note: The Edit > Preferences menu selection in Project Navigator allows you to control the 
frequency of the automatic checks that happen at Project Navigator startup time

XilinxUpdate Network Installations

By default, the Automatically check for software updates option at Project Navigator 
startup is enabled on the machine used to install the ISE software to the network location. 
All clients pointing to this network location have this option disabled by default. Client 
users have the option of enabling this option (Edit > Preferences > XilinxUpdate from 
Project Navigator) and also running manual checks. 

Note: To perform a software update installation, you must have write permissions for the $XILINX 
installation directory. 

Download Center
Software updates for all platforms are regularly made available on the Download Center 
at: 

http://www.xilinx.com/support/download/index.htm

Uninstalling ISE Design Suite 11

Microsoft Windows
The following sections describe how to uninstall the products that comprise ISE Design 
Suite on Microsoft Windows

To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu 
folder. For instance, to uninstall ISE, select Start > Programs > Xilinx Tools > Xilinx ISE 
Design Suite 11 > Accessories > Uninstall Xilinx ISE Design Suite.

Alternatively, you can use the appropriate uninstall entry in the Add or Remove Programs 
dialog box, accessed via the Windows Control Panel. Possible entries include:

• Xilinx ChipScope™ Pro 11

• Xilinx DSP Tools (System Generator, AccelDSP™) 11

• Xilinx EDK 11

• Xilinx ISE 11

• Xilinx PlanAhead 11

Depending on what you have installed, some ancillary applications may also need to be 
uninstalled, such as WinPcap 4.0 (optional component of DSP Tools).
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Linux 
To uninstall a Xilinx Design Suite product, you need to remove the appropriate product 
directory that is found in the Design Suite root directory. Type in ./xsetup -uninstall 
in the shell.

Before uninstalling, be sure you have moved any project files that you want to keep 
outside your Xilinx installation directory structure, or they will be deleted.

Installing ModelSim Xilinx Edition 6.4b Software (Windows Only) - 
Optional

If you have already purchased ModelSim Xilinx Edition (MXE) 6.4b, you will receive a 
license file after registering the MXE software after installation. For complete product and 
purchasing information for MXE, contact your local Xilinx representative or visit the 
ModelSim Xilinx Edition website:

http://www.xilinx.com/ise/optional_prod/mxe.htm

To install MXE software, perform the following steps:

1. Insert the ModelSim Xilinx Edition CD. 

2. If the CD does not automatically run, select Start > Run > D:\setup.exe.

3. Follow the instructions to complete the installation.

4. Follow the instructions provided to complete a license request. 

A license file will be e-mailed to you.

5. Put the license in a location pointed to by the LM_LICENSE_FILE variable as follows:

set LM_LICENSE_FILE=<path_to_license>\license.dat

You can also cut and paste the contents into your existing license.dat file.

Note: MXE is not a supported simulator for Xilinx Platform Studio.
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Chapter 5

Obtaining and Managing a License

The Xilinx® Product Download and Licensing Site is an online service for downloading, 
licensing, and administering evaluation, and full copies of Xilinx software and IP products. 
This chapter describes the FLEXnet license generation functionality of the Product 
Download and Licensing Site. It includes the following sections:

• “Accessing the Product Download and Licensing Site”

• “Product Licensing Accounts”

• “User Types and Actions”

• “Creating a License Key File”

• “Managing License Key Files”

• “Managing User Access to Product Licensing Account”

• “Installing Your License Key File”

Accessing the Product Download and Licensing Site
The Product Download and Licensing Site is accessible in various ways depending upon 
the type of license being generated.

• If you purchased products, follow the link included in your order confirmation email. 
It will provide direct access to an account containing your product entitlements.

• If you want to evaluate ISE® Design Suite 11 products, go to 
www.xilinx.com/ise_eval.

• If you want to evaluate IP products, go to www.xilinx.com/ipcenter and follow the 
“Evaluate” link on the IP product page of interest.

• You may also access the Product Download and Licensing Site directly by going to 
www.xilinx.com/getproduct. You will need to register or enter your registration 
information first.
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Chapter 5: Obtaining and Managing a License
You must first sign in. If you already have a Xilinx user account, enter your user ID and 
password, and then validate that your contact information is current. If you do not have an 
account, click the Create Account button.

Product Licensing Accounts
When you purchase a software or IP product from Xilinx, you are purchasing a license to 
use and receive updates for that product for one year. The license to use Xilinx software 
and IP products is managed through the use of product entitlements. A product 
entitlement is the determination of:

• Which product was purchased

• The number of seats purchased

• The license type (floating or node-locked)

• The product subscription period (product updates are provided throughout the year)

In addition to managing the product entitlements for your purchased software tools and 
IP, you can also access product entitlements for “No Charge” or “Evaluation” products. 
Full and No Charge licenses have a subscription period of one year. Software tools 
evaluations are for 30 days, and IP evaluations are for 120 days.

Activating a product entitlement results in one or more license keys being generated by the 
website. When installed, the license keys enable the use of the software and IP that was 

X-Ref Target - Figure 5-1

Figure 5-1: Xilinx Sign In Page
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purchased or is being evaluated. Your product entitlements and resulting license key files 
are managed in a product licensing account on the Xilinx website.

Product licensing accounts are specific to the individual listed on the Xilinx Software 
Purchase Order, which is either the end-user or administrator of the software. All 
purchases made can be managed in the same product licensing account if a single 
administrator is named, or a company site can have multiple accounts managed by 
different administrators. The latter is helpful if a site has multiple design teams working on 
differing projects with different budget pools.

Note: A license key can be generated for a product entitlement that has expired; however, it will only 
enable product releases up to the subscription end date. Applying a product update that was made 
available after the subscription end date of your license will result in an error.

LogiCORE IP License Generation In ISE Design Suite 11
Beginning in ISE Design Suite 11, LogiCORE™ IP licenses are no longer generated through 
lounges on the Xilinx website. Instead, the entitlement process for LogiCORE IP has been 
automated and will use the same electronic entitlement process used for other software. 
When a purchase order for LogiCORE IP is entered into the Xilinx system, it will be 
processed in less than 2 hours, following which you can generate LogiCORE IP licenses on 
the Product Download and Licensing Site, as described in this section.

Any IP and software entitlements you have purchased will appear in your list of entitled 
products when you log into the Product Download and Licensing Site. Licenses for 
Evaluation and No Charge IP will also be available on the site in a separate area. Licenses 
for all your software and IP can now be generated in one pass and are emailed to you in a 
single license file. In addition, IP core FLEXnet licenses now feature more licensing 
options, such as single or Triple-Redundant Floating Server support, and more host 
options for node-locked license keys: Ethernet MAC address, Hard-Drive Serial Number 
or USB Dongle ID.

User Types and Actions
There are three user types for the Product Download and Licensing Site: customer account 
administrator, end user, and evaluation user. 

Customer Account Administrator
An example of a typical customer account administrator is a CAD tools manager. Every 
product licensing account must have at least one customer account administrator. A 
customer account administrator can manage more than one product licensing account. 

The responsibilities as the customer account administrator include:

• Generating node-locked or floating licenses for Xilinx software and IP products.

• Adding and removing users from the product licensing account (as desired).

• Assigning administrative privileges to other users (as desired).

• Ordering product DVDs (if applicable).

The original customer account administrator is the “Ship To” contact that is identified 
during the product ordering process. That person will receive an email with instructions 
on how to download and license each of the products that were purchased. It is important 
that the customer account administrator follow the link in the email, as it will ensure that 
he can obtain access to the purchased products.
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End User
Adding end users to a product licensing account allows an engineer or design team 
member the flexibility to manage and generate license keys on their own. The end user 
may generate license keys for node-locked products entitlements within the account. An 
end user is also allowed to generate license keys for evaluation software and evaluation of 
no charge IP products. Some restrictions are placed on the role of end user.

• An end user is not able to generate floating license keys. Only customer account 
administrators can generate server based (floating) license keys. Product entitlements 
for floating licenses are not viewable by end users in an account.

• An end user is not able to view the license keys generated by other users.

• An end user is not able to add or remove other users to or from the product licensing 
account.

Evaluation User
An evaluation user is someone who would like to test-drive ISE Design Suite 11 products. 
Evaluation users can:

• Generate a 30-day free evaluation license key for ISE Design Suite 11: System Edition

• Generate license keys for evaluation and no charge IP products

• Request an ISE Design Suite 11 DVD.  Evaluation users must pay for the shipping of 
DVDs.

Note: A customer who is already licensed for a full version of an ISE Design Suite product edition 
can test-drive other ISE Design Suite product editions or IP. These product entitlements are made 
available in the same product licensing account.

All user types can download products electronically and request an ISE Design Suite 11 
DVD.
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Creating a License Key File
The Create License tab on the Product Download and Licensing Site is the starting point 
for license key file generation. The software tool and IP product entitlements you have 
purchased or wish to evaluate are presented in the product entitlement table. 

Selecting Products
Begin the license generation process for products you have purchased or wish to evaluate 
by performing the following actions:

1. Select the product licensing account you wish to administer.

2. From the Account drop-down list, select your desired account.

Note: This selection will not be available if you are only entitled to evaluation or free products.

X-Ref Target - Figure 5-2

Figure 5-2: Create New License
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3. Make your product selections from the product entitlement table.

The type of product entitlements available are Full (purchased), No Charge, or Evaluation. 
Full and No Charge licenses have a subscription period of 1 year. Software tools evaluation 
is for 30 days, and IP evaluations are for 120 days.

Floating and node-locked licenses cannot be combined in the same license key file, and the 
interface is designed to prevent this.

Note: A floating license resides on a network server and enables applications to check out a license 
when they are invoked. At any one time, the number of licenses for simultaneous users is restricted 
to that of the license seats purchased. A node-locked license allows for the use of a single seat of a 
product entitlement on a specific machine.

For software tools, available seats represents the number of seats available for licensing 
over the total number of seats purchased. For IP, seats are managed according to the terms 
of the site wide license agreement.

Products with a status of “Current” are within their warranty period. Products with a 
status of “Expired” have a warranty period end date that has passed. If seats are available, 
licenses can be generated for either “Current” or “Expired” product entitlements.

The ISE Design Suite: System Edition evaluation product entitlement provides access to all 
the capabilities in the ISE Design Suite tool set. This product entitlement is automatically 
included in your product licensing account.

Evaluation and No Charge IP can be added to the list of product entitlements by clicking 
the Add Evaluation and No Charge IP Cores button. This brings up an IP product finder 
tool pictured below.

Note: ISE Design Suite 10.1 users who have software tools contracts that have not yet expired will 
have the choice to generate node-locked or floating licenses for their products that remain in warranty. 
These are referred to as “transitional licenses”. 

X-Ref Target - Figure 5-3

Figure 5-3: IP Product Selector 
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Note: IP products are typically sold as site licenses providing the administrator the ability to 
generate license keys for floating and node-locked license types.

Note: End users will only see product entitlements for node-locked products. The customer account 
administrator will see product entitlements for both node-locked and floating products.

Generating a License
Click the Generate License button that corresponds to the type of license key file you are 
generating (floating or node-locked). The license generation form shown below appears.

Complete the form as follows:

1. Select the number of seats required for each product license. 

This is for floating licenses only. All node-locked licenses are for one seat. The number 
of seats available for a product entitlement is automatically maintained by the system. 

X-Ref Target - Figure 5-4

Figure 5-4: Generate Floating License
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The "Requested Seats" field is populated, by default, with the full number of seats 
remaining on the product entitlement. A product is removed from the product 
entitlement table if all seats have been activated.

2. Enter system information.

System information is pre-populated in the option menu if you arrived at the Product 
Download and Licensing Site from a link within the Xilinx License Configuration 
Manager (XLCM).

A redundant server configuration provides a fail over for the license manager 
software. As long as two of the three servers are running, the license manager can 
continue to run.

If you do not have pre-populated system information or wish to add a different host, 
select the Add a host option from the option menu.

The host ID is a value that uniquely identifies the machine to which your software 
tools or IP is licensed. You may choose a host ID type to be a MAC address, a hard 
drive serial number, a dongle ID, or a Solaris host ID.

Note: Not all host ID types are supported for all operating systems. The easiest way to obtain 
your host ID is to run the XLCM on the machine that will serve as the license host.

3. Enter a comment.

Adding a comment to the license key file makes it easy for an administrator to keep 
notes on how software and IP product entitlements are allocated among users.

4. Click Next.

The Review License Request form appears.

X-Ref Target - Figure 5-5

Figure 5-5: Add a Host
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5. Review your selections. 

6. If you are satisfied with your selections, click Next.

End User License Agreements (EULAs)

ISE Design Suite Software tools and No Charge IP product EULAs are agreed to during the 
product installation process. If you license IP products, you must accept the terms of the 
associated IP product EULAs before the license file can be generated.

Third-Party Licenses

A complete copy of the third-party licenses for 11.4 is located here: <install 
directory>/common/installer/idata/usenglish/idata/licenses/unified_3rd_party_eulas
_11_4.txt 

License Generation Confirmation

Upon completion of the license generation process, you will receive a confirmation 
message providing a summary of your licensing activity.

X-Ref Target - Figure 5-6

Figure 5-6: Review License Request
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You will also receive a license generation confirmation email. This message contains the 
license key file that was generated as an attachment. Add 
‘xilinx.notification@entitlenow.com’ as a trusted sender in your email address book.

Managing License Key Files
The Product Download and Licensing Site keeps track of the license key files you have 
generated. Select the ‘Manage Licenses’ tab to see all of the license key files that have been 
generated for your product licensing account.

X-Ref Target - Figure 5-7

Figure 5-7: License Generation Confirmation
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From the Manage Licenses page, the actions described below can be taken depending 
upon your needs.

X-Ref Target - Figure 5-8

Figure 5-8: Manage Licenses
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Exploring and Retrieving Your Existing License Key Files
Information regarding the license key files that have been generated in your product 
licensing account are presented in a “master / detail” view. By clicking on a row in the 
master view in the top table, detailed information about the license key file is displayed in 
the detail view in the bottom table. The detail view table includes the following:

• A list of product entitlements that have been activated in the key file.

• Comments associated with the key file.

• Ability to download, email, or copy and paste the contents of the license key file (click 
the corresponding icons on the lower left portion of the detail view).

• Ability to delete a license key file.

• Ability to view the end user license agreement you accepted (if applicable).

Modifying a License Key File
In order to modify an existing license key file, select the license key file in the master view 
and then click the Modify License button in the detail view. A license key file can be 
modified in one of the following ways:

• Rehosting or changing the license server host for a license key file.

• Activating or adding additional seats to an existing licensed product entitlement.

• Deactivating or removing seats from an existing licensed product entitlement.

• Activating or adding additional product entitlements to a license key file.

• Deactivating or deleting product entitlements from a license key file.

The process for modifying a key file uses the same input form as when the license key file 
was created except that additional product entitlements of the same license type (floating 
or node-locked) are made available for licensing.

Reclaiming Deactivated Product Entitlements
A product entitlement is deactivated when one of the following activities occur:

• Rehosting or changing the license server host for a license key file.

• Deactivating or removing seats from an existing licensed product entitlement.

• Deactivating or deleting product entitlements from a license key file.

The license generation facility will allow for the reallocation of the deactivated seats or 
product entitlements by making the corresponding seats or product entitlements available 
for activation in the product entitlements table on the Create License page.

Before the reallocation of entitlement occurs, you must first agree to an Affidavit of 
Destruction. This legal agreement is required to ensure that the deactivated product 
entitlements are no longer being used.

The number of allocation operations is recorded for each user. Administrators are allowed 
to reallocate product entitlements five times per major release, and end users are allowed 
to reallocate product entitlements three times per major release.
56 www.xilinx.com ISE Design Suite 11 Release Notes
UG631 (v 11.5)

http://www.xilinx.com


Managing User Access to Product Licensing Account
What Happens to Your License Key File
For each product entitlement that is activated, a FLEXnet increment line and 
corresponding package line is added to the license key file. When a license key file is 
modified to activate (add) seats for an existing or new product entitlement, additional 
increment or package lines are added to the license key file.

When a license key file is “rehosted” or is modified to deactivate (delete) seats or product 
entitlements, the corresponding increment lines are regenerated or removed from the 
modified license key file.

Managing User Access to Product Licensing Account
The responsibility of administering a product licensing account may be transferred or 
shared with another user. The ability to add or remove users from a product licensing 
account is managed under the ‘Manage Users’ tab.

X-Ref Target - Figure 5-9

Figure 5-9: Manage Users
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Adding Users
To add a user to your product licensing account:

1. Type in the corporate email address of the new user. 

2. Check the Designate user as administrator check box if you want the new user to 
have customer account administrative privileges.

Note: The email address you provide must be the same email address the user supplied or supplies 
when creating their Xilinx account. If not, the user may not be properly recognized when logging in.

If a user has already logged into the Product Download and Licensing Site, their name will 
automatically appear in the user list. If the user has never been to the site, the words “Not 
Yet Registered” will appear in the space for their name. Once the user has completed the 
sign in process, their name will be filled in.

In some instances, a customer account administrator may wish to have design team 
members administer license key files for their own use. By not checking the “Designate 
user as administrator” check box, the user will have the following restricted privileges:

• Only able to generate node-locked license keys.

• Only able to view and modify license key files they generated for themselves.

• Unable to manage users.

Removing Users
Administrative privileges may be removed from users of an account by unchecking the 
“Administrator” check box that corresponds to the respective user.

To remove a user from a product licensing account, click the Trash can icon that 
corresponds to the respective user.

Installing Your License Key File 

Node Lock License Installation
After generating a license file, you will receive an e-mail from 
‘xilinx.notification@entitlenow.com’.

1. Save the license file attached to the e-mail to a temporary directory on your local 
system 

2. Run the Xilinx License Configuration Manager: 

♦ For Windows: Select Start > Programs > Xilinx ISE Design Suite 11 > Manage 
Xilinx Licenses.

♦ For Linux: Type xlcm in a command-line shell.

3. Go to the 'Manage Xilinx Licenses' tab. 

4. Click the Copy License button at the top of the page. 

5. Browse to your license file (Xilinx.lic) and click Open.

This will copy this license file to the C:\.Xilinx (Windows) or <Home>/.Xilinx 
directory of your machine where it will be automatically found by the Xilinx tools.
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6. Following the “Copy License” operation, the table on the Manage Xilinx Licenses tab 
will be updated with licensing information from the license file. 

7. Press Close to exit the Xilinx License Configuration Manager.

Floating License Installation on Servers
For existing FLEXnet license servers, a common practice is to copy the contents of the 
license file, mailed from ‘xilinx.notification@entitlenow.com’, into the existing license file 
on your FLEXnet server.

Note: Restart the floating license server to enable the Xilinx licenses.

For New License Servers 
1. Download the appropriate Xilinx FLEXnet license utilities for your server's operating 

system from the Xilinx Download Center:

http://www.xilinx.com/download/index.htm

Note: Only customer account administrators on the Product Download and Licensing Site have 
access to FLEXnet license utilities. To see if you are a customer account administrator, refer to 
the description in “User Types and Actions.”

2. Unzip these utilities into a destination directory. It is recommended that you place this 
directory into your application search path. 

3. Once the FLEXnet utilities are installed, you can run the following commands to start 
the floating license server:

♦ For Linux 

- <Server Tool directory>/bin/lin/lmgrd -c <path_to_license>/Xilinx.lic -l 
<path_to_license>/log1.log 

- <Server Tool directory> bin/lin64/lmgrd -c <path_to_license>/Xilinx.lic -l 
<path_to_license>/log1.log

♦ For Windows 

- < Server Tool directory>\bin\nt\lmgrd -c <path_to_license>\Xilinx.lic –l 
<path_to_license>\log1.log 

- < Server Tool directory>\bin\nt64\lmgrd -c <path_to_license>\Xilinx.lic –l 
<path_to_license>\log1.log

Client machines pointing to a floating license
1. Run the Xilinx License Configuration Manager (XLCM). 

2. From the Acquire a License screen of the XLCM, click the ‘Manage Xilinx Licenses’ tab. 

3. On the Manage Xilinx Licenses tab, enter the network path to the license server in the 
port@server format into the XILINXD_LICENSE_FILE field, and press the Set button 
next to it. The default Xilinx port number is 2100. 

Note: For Linux operating systems, licensing environment variables cannot be set using the Xilinx 
License Configuration Manager (XLCM). The environment variable fields are read only, and they are 
grayed out and there are no “Set” buttons. The environment variable must be set using the 
appropriate shell and commands.
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Chapter 6

Technical Support, Services, and 
Documentation

This chapter describes how to access technical support, services, and documentation that 
are available. This chapter contains the following sections:

• “Technical Support”

• “Education Services”

• “Documentation”

Technical Support 
For technical questions, visit the Xilinx® support site,

www.xilinx.com/support/mysupport.htm

where you can search the Answers Database or utilize the following self support features: 

• Documentation Center , www.xilinx.com/support/documentation/index.htm

• Download Center, www.xilinx.com/support/download/index.htm

• Answer Browser, www.xilinx.com/support/answers/index.htm

• Xilinx User Community Forums, http://forums.xilinx.com/xlnx

• Design Resources - Video Demonstrations, www.xilinx.com/design

If you cannot resolve your issue using our online resources, you can contact Xilinx 
Technical Support directly at:

www.xilinx.com/support/techsup/tappinfo.htm

Education Services
Xilinx provides targeted, high-quality education services designed by experts in 
programmable logic design, and delivered by Xilinx qualified trainers. Available are onsite 
and online instructor led courses, and recorded e-learning for self paced learning.

For more information on training courses, free on-demand training, live online training, 
and upcoming events, visit the Xilinx Training website,

www.xilinx.com/support/education-home.htm
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Documentation
Xilinx offers technical documentation to assistant users with using the ISE® Design Suite 
tools.

Context-Sensitive Help
Context-sensitive online Help is available for most ISE Design Suite tools that are available 
with a graphical user interface (GUI). From Project Navigator, select Help > Help Topics to 
access the online Help. 

Software Manuals
Detailed software manuals about the ISE Design Suite applications and command-line 
functions are included as part of the software installation. After you install the software, 
you can select the Help > Software Manuals command in Project Navigator to access the 
software manuals collection.

Note: If you do not already have Adobe Acrobat Reader installed, you must do so to view the 
software manuals.

A new documentation navigation page is now the default startup page in Xilinx Platform 
Studio (XPS). From the documentation tab you can browse to all Embedded Development 
Kit (EDK) documentation. From outside XPS, open the file 
edk_documentation_locator.htm, which is found at $XILINX_EDK/doc.

To locate the Software Manuals on the website:

1. Go to the Documentation Center, 
http://www.xilinx.com/support/documentation/index.htm

2. Click the Design Tools tab.

3. Click the Design Tool category, such as ISE, or click the See All Design Tools 
Documentation link.

User Tutorials
Tutorials can be found online at:

http://www.xilinx.com/support/techsup/tutorials/index.htm
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Appendix A

Third-Party Licenses

The following licenses govern the use of certain third-party technology included in and/or 
distributed in connection with the Xilinx ISE® Design Suite software tools. Each license 
applies only to the applicable technology expressly governed by such license and not to 
any other technology. 

PERL License
XILPERL is a modified version of PERL licensed under the Artistic license. The text of the 
artistic license may be seen at http://www.perl.com/language/misc/Artistic.html.

XILPERL is invoked implicitly by the ISE Design Suite software when it is needed and 
there is no need for the user to invoke it directly. The only difference between XILPERL and 
unmodified PERL is that XILPERL picks up its input script file from the location specified 
in the Xilinx environment variable, and not from STDIN. 

XILPERL is not packaged in the ISE Design Suite software by Xilinx with the intention for 
it to be used as a standalone PERL by the end user. The unmodified version of PERL may 
be obtained in source or executable form from http://www.perl.com. 

Scintilla and SciTE License
The ISE Design Suite software’s graphical user interface uses the Scintilla Source Code 
Editor licensed under the following terms: 

Copyright 1998-2003 by Neil Hodgson <neilh@scintilla.org>

All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for 
any purpose and without fee is hereby granted, provided that the above copyright 
notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. 

NEIL HODGSON DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS, IN NO EVENT SHALL NEIL HODGSON BE LIABLE FOR ANY 
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER 
IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE. 
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Regex License
The ISE Design Suite software contains the Regex software from the Boost libraries 
licensed under the following terms:

Copyright © 1998-2000

Dr John Maddock

Permission to use, copy, modify, distribute and sell this software and its 
documentation for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this 
permission notice appear in supporting documentation. Dr John Maddock makes no 
representations about the suitability of this software for any purpose. It is provided “as 
is” without express or implied warranty.

Integer Traits License
The ISE Design Suite software contains the Integer Traits software from the Boost libraries 
licensed under the following terms:

Copyright Jens Maurer 2000

Permission to use, copy, modify, sell, and distribute this software is hereby granted 
without fee provided that the above copyright notice appears in all copies and that 
both that copyright notice and this permission notice appear in supporting 
documentation, Jens Maurer makes no representations about the suitability of this 
software for any purpose. It is provided “as is” without express or implied warranty.

Apache Software License
The ISE Design Suite software includes some software developed by the Apache Software 
Foundation (http://www.apache.org/). The Apache software is licensed under the 
following terms:

The Apache Software License, Version 1.1 

Copyright © 1999 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include 
the following acknowledgment: 

“This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/).” Alternately, this acknowledgment may appear in the 
software itself, if and wherever such third-party acknowledgments normally appear. 

4. The names “Sources” and “Apache Software Foundation” must not be used to 
endorse or promote products derived from this software without prior written 
permission. For written permission, please contact apache@apache.org. 
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5. Products derived from this software may not be called “Apache”, nor may “Apache” 
appear in their name, without prior written permission of the Apache Software 
Foundation. 

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE 
FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf 
of the Apache Software Foundation and was originally based on software copyright © 
1999, International Business Machines, Inc., http://www.ibm.com. For more 
information on the Apache Software Foundation, please see 
http://www.apache.org/. 

Netscape License
The ISE Design Suite software contains “remote.c” code licensed under the following 
terms: 

/* -*- Mode:C; tab-width: 8 -*-  
remote.c --- remote control of Netscape Navigator for Unix. 
version 1.1.3, for Netscape Navigator 1.1 and newer.

Copyright © 1996 Netscape Communications Corporation, all rights reserved.

Created: Jamie Zawinski <jwz@netscape.com>, 24-Dec-94.

Permission to use, copy, modify, distribute, and sell this software and its 
documentation for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this 
permission notice appear in supporting documentation. No representations are made 
about the suitability of this software for any purpose. It is provided “as is” without 
express or implied warranty.

Info-ZIP License
The ISE Design Suite software contains Info-ZIP software licensed under the following 
terms:

This is version 2002-Feb-16 of the Info-ZIP copyright and license.

The definitive version of this document should be available at 
ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.

Copyright © 1990-2002 Info-ZIP. All rights reserved.

For the purposes of this copyright and license, "Info-ZIP" is defined as the following 
set of individuals:
ISE Design Suite 11 Release Notes www.xilinx.com 65
UG631 (v 11.5)

http://www.xilinx.com


Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup 
Gailly, Hunter Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, 
Robert Heath, Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno 
van der Linden, Igor Mandrichenko, Steve P. Miller,Sergio Monesi, Keith Owens, 
George Petrov, Greg Roelofs, Kai Uwe Rommel,Steve Salisbury, Dave Smith, Christian 
Spieler, Antoine Verheijen,Paul von Behren, Rich Wales, Mike White

This software is provided "as is”, without warranty of any kind, express or implied. In 
no event shall Info-ZIP or its contributors be held liable for any direct, indirect, 
incidental, special or consequential damages arising out of the use of or inability to use 
this software.

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, 
disclaimer, and this list of conditions.

2. Redistributions in binary form (compiled executables) must reproduce the above 
copyright notice, definition, disclaimer, and this list of conditions in documentation 
and/or other materials provided with the distribution. The sole exception to this 
condition is redistribution of a standard UnZipSFX binary as part of a self-extracting 
archive; that is permitted without inclusion of this license, as long as the normal 
UnZipSFX banner has not been removed from the binary or disabled.

3. Altered versions--including, but not limited to, ports to new operating systems, 
existing ports with new graphical interfaces, and dynamic, shared, or static library 
versions--must be plainly marked as such and must not be misrepresented as being the 
original source. Such altered versions also must not be misrepresented as being Info-
ZIP releases--including, but not limited to, labeling of the altered versions with the 
names "Info-ZIP" (or any variation thereof, including, but not limited to, different 
capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of 
Info-ZIP. Such altered versions are further prohibited from misrepresentative use of 
the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," 
"WiZ," "Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary 
releases.

bgexec License
The ISE Design Suite software contains bgexec software licensed under the following 
terms:

Copyright 1991-1998 by Bell Labs Innovations for Lucent Technologies.

Permission to use, copy, modify, and distribute this software and its documentation for 
any purpose and without fee is hereby granted, provided that the above copyright 
notice appear in all copies and that both that the copyright notice and warranty 
disclaimer appear in supporting documentation, and that the names of Lucent 
Technologies any of their entities not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all 
implied warranties of merchantability and fitness. In no event shall Lucent 
Technologies be liable for any special, indirect or consequential damages or any 
damages whatsoever resulting from loss of use, data or profits, whether in an action of 
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contract, negligence or other tortuous action, arising out of or in connection with the 
use or performance of this software.

CURL Library License
The ISE Design Suite software uses the CURL library licensed under the following terms:

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1996 - 2006, Daniel Stenberg, <daniel@haxx.se>.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or 
without fee is hereby granted, provided that the above copyright notice and this 
permission notice appear in all copies.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in 
advertising or otherwise to promote the sale, use or other dealings in this Software 
without prior written authorization of the copyright holder.

Zlib (v1.2.2) License
zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.2, October 3rd, 2004

Copyright © 1995-2004 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software. 
Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org 
Mark Adler madler@alumni.caltech.edu

Zlib (v1.2.3) License
zlib.h -- interface of the 'zlib' general purpose compression library
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version 1.2.3, July 18th, 2005

Copyright © 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software. 
Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org 
Mark Adler madler@alumni.caltech.edu

iText License
The iText module (http://www.lowagie.com/iText/) is licensed under the Mozilla Public 
License 1.1 that may be seen at http://www.lowagie.com/iText/MPL-1.1.txt. The 
ChipScope™ Pro Analyzer waveform print menu option uses the iText module to 
implement the PDF writer feature.

JDOM License
The JDOM module (http://www.jdom.org) is licensed under the terms listed in the license 
agreement that can be found in the Apache-style open source license file that is found at: 
<install_dir>/bin/<platform>/JDOM_LICENSE>TXT (where <install_dir> is the 
ChipScope Pro installation directory and <platform> is one of nt, nt64, lin, or lin64, 
depending on the system platform type). The ChipScope Pro tools use the JDOM module 
to parse XML files.

Java Runtime Environment (JRE) License
The JRE module (http://java.sun.com) is licensed under the terms listed in the Sun 
Microsystems, Inc.Binary Code License Agreement that can be seen at: 
http://java.sun.com/j2se/1.5.0/jre-1_5_0_14-license.txt. Also, the license agreement can 
be found in the file called <install_dir>/bin/<platform>/jre1.5.0/LICENSE 
(where <install_dir> is the ChipScope Pro installation directory and <platform> is one of nt, 
nt64, lin, or lin64, depending on the system platform type). The ChipScope Pro tools use 
the JRE to run the Java-based application programs.

OpenSSL License
Both licenses below apply to the OpenSSL toolkit:

Copyright © 1998-2008 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:
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1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display 
the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse 
or promote products derived from this software without prior written permission. For 
written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may 
“OpenSSL” appear in their names without prior written permission of the OpenSSL 
Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL 
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). 
The implementation was written so as to conform with Netscapes SSL. This library is 
free for commercial and non-commercial use as long as the following conditions are 
adhered to. The following conditions apply to all code found in this distribution, be it 
the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation 
included with this distribution is covered by the same copyright terms except that the 
holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not 
to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a 
textual message at program startup or in documentation (online or textual) provided 
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with the package. Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display 
the following acknowledgement:

“This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com)” 

The word 'cryptographic' can be left out if the routines from the library being used are 
not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps 
directory (application code) you must include an acknowledgement: “This product 
includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of 
this code cannot be changed. i.e. this code cannot simply be copied and put under 
another distribution licence [including the GNU Public Licence.]

ABC License
ABC Logic Synthesis and Verification System software from UC Berkeley is licensed under 
the following terms: 

Copyright © The Regents of the University of California. All rights reserved.

Permission is hereby granted, without written agreement and without license or 
royalty fees, to use, copy, modify, and distribute this software and its documentation 
for any purpose, provided that the above copyright notice and the following two 
paragraphs appear in all copies of this software.

IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY 
PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS 
DOCUMENTATION, EVEN IF THE UNIVERSITY OF CALIFORNIA HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
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WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN “AS IS” BASIS, 
AND THE UNIVERSITY OF CALIFORNIA HAS NO OBLIGATION TO PROVIDE 
MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

Open LDAP License
The OpenLDAP Public License

Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with 
or without modification, are permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and 
notices, this list of conditions, and the following disclaimer in the documentation and/or 
other materials provided with the distribution, and

3. Redistributions must contain a verbatim copy of this document. The OpenLDAP 
Foundation may revise this license from time to time. Each revision is distinguished by a 
version number. You may use this Software under terms of this license revision or under 
the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS 
CONTRIBUTORS “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

The names of the authors and copyright holders must not be used in advertising or 
otherwise to promote the sale, use or other dealing in this Software without specific, 
written prior permission. Title to copyright in this Software shall at all times remain with 
copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All 
Rights Reserved. Permission to copy and distribute verbatim copies of this document is 
granted.

Graphviz License
Graphviz (Graph Visualization Software) was obtained from www.graphviz.org under the 
Common Public License below. Xilinx has not made any changes or additions to Graphviz 
(i.e., there is no “Contribution” originating from Xilinx) within the meaning of the 
Common Public License. Your use of Graphviz is subject to the terms and conditions set 
forth by applicable third-party Contributor(s) under the Common Public License below. 
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Source code to Graphviz is available from the applicable third-party Contributor(s) at 
www.graphviz.org under the terms and conditions of the Common Public License below.

Common Public License Version 1.0

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS 
COMMON PUBLIC LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR 
DISTRIBUTION OF THE PROGRAM CONSTITUTES RECIPIENT'S ACCEPTANCE 
OF THIS AGREEMENT.

1. DEFINITIONS

"Contribution" means:

a) in the case of the initial Contributor, the initial code and documentation distributed 
under this Agreement, and

b) in the case of each subsequent Contributor:

i) changes to the Program, and

ii) additions to the Program;

where such changes and/or additions to the Program originate from and are 
distributed by that particular Contributor. A Contribution 'originates' from a 
Contributor if it was added to the Program by such Contributor itself or anyone 
acting on such Contributor's behalf. Contributions do not include additions to the 
Program which: (i) are separate modules of software distributed in conjunction 
with the Program under their own license agreement, and (ii) are not derivative 
works of the Program.

"Contributor" means any person or entity that distributes the Program.

"Licensed Patents " mean patent claims licensable by a Contributor which are 
necessarily infringed by the use or sale of its Contribution alone or when combined 
with the Program.

"Program" means the Contributions distributed in accordance with this Agreement.

"Recipient" means anyone who receives the Program under this Agreement, including 
all Contributors.

2. GRANT OF RIGHTS

a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a 
non-exclusive, worldwide, royalty-free copyright license to reproduce, prepare 
derivative works of, publicly display, publicly perform, distribute and sublicense the 
Contribution of such Contributor, if any, and such derivative works, in source code 
and object code form.

b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a 
non-exclusive, worldwide, royalty-free patent license under Licensed Patents to make, 
use, sell, offer to sell, import and otherwise transfer the Contribution of such 
Contributor, if any, in source code and object code form. This patent license shall apply 
to the combination of the Contribution and the Program if, at the time the Contribution 
is added by the Contributor, such addition of the Contribution causes such 
combination to be covered by the Licensed Patents. The patent license shall not apply 
to any other combinations which include the Contribution. No hardware per se is 
licensed hereunder.

c) Recipient understands that although each Contributor grants the licenses to its 
Contributions set forth herein, no assurances are provided by any Contributor that the 
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Program does not infringe the patent or other intellectual property rights of any other 
entity. Each Contributor disclaims any liability to Recipient for claims brought by any 
other entity based on infringement of intellectual property rights or otherwise. As a 
condition to exercising the rights and licenses granted hereunder, each Recipient 
hereby assumes sole responsibility to secure any other intellectual property rights 
needed, if any. For example, if a third party patent license is required to allow 
Recipient to distribute the Program, it is Recipient's responsibility to acquire that 
license before distributing the Program.

d) Each Contributor represents that to its knowledge it has sufficient copyright rights 
in its Contribution, if any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own 
license agreement, provided that:

a) it complies with the terms and conditions of this Agreement; and

b) its license agreement:

i) effectively disclaims on behalf of all Contributors all warranties and conditions, 
express and implied, including warranties or conditions of title and non-
infringement, and implied warranties or conditions of merchantability and fitness 
for a particular purpose;

ii) effectively excludes on behalf of all Contributors all liability for damages, 
including direct, indirect, special, incidental and consequential damages, such as 
lost profits;

iii) states that any provisions which differ from this Agreement are offered by that 
Contributor alone and not by any other party; and

iv) states that source code for the Program is available from such Contributor, and 
informs licensees how to obtain it in a reasonable manner on or through a medium 
customarily used for software exchange.

When the Program is made available in source code form:

a) it must be made available under this Agreement; and

b) a copy of this Agreement must be included with each copy of the Program.

Contributors may not remove or alter any copyright notices contained within the 
Program.

Each Contributor must identify itself as the originator of its Contribution, if any, in a 
manner that reasonably allows subsequent Recipients to identify the originator of the 
Contribution.

4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to 
end users, business partners and the like. While this license is intended to facilitate the 
commercial use of the Program, the Contributor who includes the Program in a 
commercial product offering should do so in a manner which does not create potential 
liability for other Contributors. Therefore, if a Contributor includes the Program in a 
commercial product offering, such Contributor ("Commercial Contributor") hereby 
agrees to defend and indemnify every other Contributor ("Indemnified Contributor") 
against any losses, damages and costs (collectively "Losses") arising from claims, 
lawsuits and other legal actions brought by a third party against the Indemnified 
Contributor to the extent caused by the acts or omissions of such Commercial 
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Contributor in connection with its distribution of the Program in a commercial 
product offering. The obligations in this section do not apply to any claims or Losses 
relating to any actual or alleged intellectual property infringement. In order to qualify, 
an Indemnified Contributor must: a) promptly notify the Commercial Contributor in 
writing of such claim, and b) allow the Commercial Contributor to control, and 
cooperate with the Commercial Contributor in, the defense and any related settlement 
negotiations. The Indemnified Contributor may participate in any such claim at its 
own expense.

For example, a Contributor might include the Program in a commercial product 
offering, Product X. That Contributor is then a Commercial Contributor. If that 
Commercial Contributor then makes performance claims, or offers warranties related 
to Product X, those performance claims and warranties are such Commercial 
Contributor's responsibility alone. Under this section, the Commercial Contributor 
would have to defend claims against the other Contributors related to those 
performance claims and warranties, and if a court requires any other Contributor to 
pay any damages as a result, the Commercial Contributor must pay those damages.

5. NO WARRANTY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS 
PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Each Recipient is solely responsible for determining the appropriateness of 
using and distributing the Program and assumes all risks associated with its exercise 
of rights under this Agreement, including but not limited to the risks and costs of 
program errors, compliance with applicable laws, damage to or loss of data, programs 
or equipment, and unavailability or interruption of operations.

6. DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT 
NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM 
OR THE EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.

7. GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it 
shall not affect the validity or enforceability of the remainder of the terms of this 
Agreement, and without further action by the parties hereto, such provision shall be 
reformed to the minimum extent necessary to make such provision valid and 
enforceable.

If Recipient institutes patent litigation against a Contributor with respect to a patent 
applicable to software (including a cross-claim or counterclaim in a lawsuit), then any 
patent licenses granted by that Contributor to such Recipient under this Agreement 
shall terminate as of the date such litigation is filed. In addition, if Recipient institutes 
patent litigation against any entity (including a cross-claim or counterclaim in a 
lawsuit) alleging that the Program itself (excluding combinations of the Program with 
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other software or hardware) infringes such Recipient's patent(s), then such Recipient's 
rights granted under Section 2(b) shall terminate as of the date such litigation is filed.

All Recipient's rights under this Agreement shall terminate if it fails to comply with 
any of the material terms or conditions of this Agreement and does not cure such 
failure in a reasonable period of time after becoming aware of such noncompliance. If 
all Recipient's rights under this Agreement terminate, Recipient agrees to cease use 
and distribution of the Program as soon as reasonably practicable. However, 
Recipient's obligations under this Agreement and any licenses granted by Recipient 
relating to the Program shall continue and survive. Everyone is permitted to copy and 
distribute copies of this Agreement, but in order to avoid inconsistency the Agreement 
is copyrighted and may only be modified in the following manner. The Agreement 
Steward reserves the right to publish new versions (including revisions) of this 
Agreement from time to time. No one other than the Agreement Steward has the right 
to modify this Agreement. IBM is the initial Agreement Steward. IBM may assign the 
responsibility to serve as the Agreement Steward to a suitable separate entity. Each 
new version of the Agreement will be given a distinguishing version number. The 
Program (including Contributions) may always be distributed subject to the version of 
the Agreement under which it was received. In addition, after a new version of the 
Agreement is published, Contributor may elect to distribute the Program (including its 
Contributions) under the new version. Except as expressly stated in Sections 2(a) and 
2(b) above, Recipient receives no rights or licenses to the intellectual property of any 
Contributor under this Agreement, whether expressly, by implication, estoppel or 
otherwise. All rights in the Program not expressly granted under this Agreement are 
reserved.

This Agreement is governed by the laws of the State of New York and the intellectual 
property laws of the United States of America. No party to this Agreement will bring 
a legal action under this Agreement more than one year after the cause of action arose. 
Each party waives its rights to a jury trial in any resulting litigation.

Perftools License
Copyright © 2005, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

• Neither the name of Google Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
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THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

JGoodies License
Copyright © 2001-2008 JGoodies Karsten Lentzsch. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

• Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific 
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
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Third-Party Additional License Agreement (Effective Beginning in 11.3)
The ISE Design Suite software graphical user interface supports the MNG file format by 
using libmng licensed from linmng.com and the Contributing Authors, whose 
contributions are hereby acknowledged.

Third-Party Additional License Agreement (Effective Beginning in 
11.3)

Libconfig (v1.3.2) License
libconfig - A library for processing structured configuration files

Copyright (C) 2005-2009  Mark A Lindner

This file is part of libconfig. 

This library is free software; you can redistribute it and/or modify it under the terms of the 
GNU Lesser General Public License as published by the Free Software Foundation; either 
version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE.  See the GNU Lesser General Public License for more 
details. 

You should have received a copy of the GNU Library General Public License along with 
this library; if not, see <http://www.gnu.org/licenses/>.

Third-Party Additional License Agreement (Effective Beginning in 
11.4)

Pthreads-win32 License
Pthreads-win32 License 
----------------------------------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------------------------------

pthreads-win32 - a POSIX threads library for Microsoft Windows

This file is Copyrighted 
-----------------------

This file is covered under the following Copyright:

Copyright (C) 2001 Rose P. Johnson 
All rights reserved.

Everyone is permitted to copy and distribute verbatim copies 
of this license document, but changing it is not allowed. 

Pthreads-win32 is covered by the GNU Lesser General Public License 
-------------------------------------------------------------

Pthreads-win32 is open software; you can redistribute it and/or 
modify it under the terms of the GNU Lesser General Public License 
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as published by the Free Software Foundation version 2.1 of the 
License.

Pthreads-win32 is distributed in the hope that it will be useful, 
but WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 
GNU Lesser General Public License for more details.

A copy of the GNU Lesser General Public License is distributed with  
pthreads-win32 under the filename:

COPYING.LIB

You should have received a copy of the version 2.1 GNU Lesser General 
Public License with pthreads-win32; if not, write to:

Free Software Foundation, Inc. 
59 Temple Place 
Suite 330 
Boston, MA 02111-1307 
USA

The contact addresses for pthreads-win32 is as follows:

Web: http://source.redhat.com/pthreads-win32 
Email: Ross Johnson <rpj@ise.canberra,edu.au>, or 
Ross.Johnson@canberra.edu.au 

Pthreads-win32 copyrights and exception files 
------------------------------------------

With the exception of the files listed below, Pthreads-win32 
is covered under the following GNU Lesser General Public License 
Copyrights.

Pthreads-win32 - PSIX Threads Library for Win32 
Copyright (C) 1998 John E. Bossom 
Copyright (C) 1999, 2002 Pthreads-win32 contributors

The current list of contributors is contained 
in the file CONTRIBUTORS included with the source 
code distribution. The current list of CONTRIBUTORS  
can also be seen at the following WWW location: 
http://source.redhat.com/pthreads-win32/contributors.html

Contact Email: rpj@ise.canberra.edu.au

These files are not covered under one of the Copyrights listed above:

COPYING 
COPYING.LIB 
tests/rwlock7.c

This file, COPYING, is distributed under the Copyright found at the  
top of this file. It is important to note that you may distribute 
verbatim copies of this file but you may not modify this file.

The file COPYING.LAB, which contains a copy of the version 2.1 
GNU Lesser General Public License, is itself copyrighted by the 
Free Software Foundation, Inc. Please note that the Free Software 
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Third-Party Additional License Agreement (Effective Beginning in 11.4)
Foundation, Inc. does NOT have a copyright over Pthreads-win32, 
only the COPYING.LIB that is supplied with pthreads-win32.

The file tests/rwlock7.c is derived from code written by 
Dave Butenhof for this book ‘Programming With POSIX(R) Threads’. 
The original code was obtained by free download from his website 
http://home.earthlink.net/~anneart/family/Threads/source.html 
and did not contain a copyright or author notice. It is assumed to 
be freely distributed.

In all cases one may use and distribute these exception files freely. 
And because one may freely distribute the LGPL covered files, the 
entire pthreads-win32 source may be freely used and distributed.

 
General Copyleft and License info 
--------------------------------

For general information on Copylefts, see:

http://www.gnu.org/copyleft/

For information on GNU Lesser General Public Licenses, see:

http://www.gnu.org/copyleft/lesser.html 
http://www.gnu.org/copyleft/lesser.txt

 
Why pthreads-win32 did not use the GNU General Public License 
--------------------------------------------------------

The goal of the pthreads-win32 project has been to 
provide a quality and complete implementation of the POSIX 
threads API for Microsoft Windows within the limits imposed 
by virtue of it being a stand-alone library and not 
linked directly to other POSIX compliant libraries. For 
example, some functions and features, such as those based 
on POSIX signals, are missing.

Pthreads-win32 is a library, available in several different 
versions depending on supported compliers, and may be used 
as a dynamically linked module or a statically linked set of 
binary modules. It is not an application on it’s own.

It was fully intended that pthreads-win32 be usable with 
commercial software not covered by either the GPL or the LGPL 
licenses. Pthreads-win32 has many contributors to it’s 
code base, many of whom have done so because they have 
used the library in commercial or proprietry software 
projects.

Releasing pthreads-win32 under the LGPL ensures that the 
library can be used widely, while at the same time ensures 
that bug fixes and improvement to the pthreads-win32 code 
itself is returned to benefit all current and future users 
of the library.

Although pthreads-win32 makes it possible for applications  
that use POSIX threads to be ported to Win32 platforms, the 
broader goal of the project is to encourage the use of open  
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standards, and in particular, to make it just a little easier 
for developers writing Win32 applications to consider 
widening the potential market for their products.
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